Designing and Implementing a Curriculum for Technology Outreach Programs

Samantha Anderson  Sean Matteo  Kenneth Ng
teletat@optonline.net  smatteo1990@yahoo.com  ken_ng57@yahoo.com
Saumitra Sahi  Shannon Watt
saumitra.sahi@gmail.com  goalkeeper@optonline.net

1. ABSTRACT
   Our task was to design and implement three different technology outreach programs. These curricula targeted three different groups: adults entering the workforce, senior citizens, and young students. Our goal for the adults and senior citizens was to increase computer knowledge among those who had scarce exposure beforehand. Computer literacy is important because computers make communication and finding information quicker and easier. Therefore, it is helpful to know basic computer skills, such as word processing, creating an email, and surfing the internet.
   The final curriculum introduced young students to engineering and technology. As shown by the decline in number of students entering engineering majors in college, the presence of science -- especially engineering -- is fading in the United States. Therefore, the goal of this program was to excite young students about possible engineering careers in the future.

2. INTRODUCTION
   Outreach programs extend services and benefits to the less fortunate. These services can range from recreation for under privileged children, to financial aid for adults and their families [3].
   For example, the Make-A-Wish Foundation has been changing lives since 1980. This foundation began in the same position as we are now and has evolved into a vast and popular organization. “From our humble beginnings with one boy’s wish to be a police officer, we’ve evolved into an organization that grants a child’s wish in the U.S. every 40 minutes.”-President David Williams [10].
   The Make-A-Wish Foundation is an example of a general outreach program, meaning it does not cover any specific topic. However, there are programs that aim to educate people in certain specific areas, including engineering and technology. Our program has this characteristic.

   2.1 Improving Computer Literacy
   The first commercially available general-purpose computer arrived in 1951[11]. Therefore, the large number of people who still are still unaware as to how to use a computer may be surprising. Some barriers which may have kept people from learning basic computer skills include lack of money, lack of time, poor teaching methods, or growing up without the need for one. In other
instances, the instructor might not have begun their lesson at a simple enough pace, proscribing them from understanding what is being taught to the best of their ability.

During the senior citizen event, the participants were provided with basic computer knowledge, allowing them to communicate with others and find information more efficiently through instruction in word processing, web browsing, and e-mail.

With the increase in the number of jobs using computers, it is becoming increasingly more critical to know how to use a computer. During the Job Seekers of Newark event the participants will be taught basic computer skills, giving them a better chance at acquiring a job.

2.2 Engineering for Children

Although many students have a general idea about what they want to do when they get older, many others are unsure. It is imperative that these students are shown the range of opportunities and career paths available to them from an early age to ease the later college application process, including the choosing of a major. During the program we exposed the students to various fields of engineering and technology, and showed them how enjoyable engineering can really be.

3. BACKGROUND

The purpose of technology outreach programs such as the ones organized this year by the New Jersey Governor’s School of Engineering and Technology, are to help various people from different backgrounds become more efficient and thus better prepared for life by introducing them to new skills, information, and contacts that could potentially make them more self-sufficient. In general, outreach programs hold the ability to encompass a broad spectrum, from programs aiming to improve leadership, and workshops teaching technical skills, to simple community events providing recreation to underprivileged kids. Newark Now is an example of a typical urban outreach program that exists with the purpose to “provide Newark residents with skills, tools, and support to transform their neighborhoods,” and to help Newarkers to “become aware of useful resources and services, help connect them to those resources and services, help government and non-governmental entities improve collaboration and coordination in the delivery of their services, and help grassroots organizations build their capacity to lead community improvement efforts”[12]. While the outreach program carried out by NJ GSET 2008 had more specific goals given only three weeks to organize three separate events, the basic, underlying purposes of GSET’s outreach were one and the same with those of other outreach organizations like Newark Now.

The outreaches organized by GSET this year had the specific goals of teaching computer literacy to senior citizens interested in learning it, presenting computer skills that would be helpful in obtaining a job, and exposing young students to interesting topics in engineering that could possibly help them develop an interest in the
science behind it. To achieve those goals, the outreach project group sought to first examine why previous attempts to teach the senior citizens were unsuccessful, and why the younger students had not been exposed to science and engineering. Thus, in organizing the outreach for the seniors and young students in Newark and Paterson, we sought to be as interactive and hands-on in our teaching approaches as possible. The outreach group created curricula, for teaching technology and engineering, and for simplifying them, thus making them more accessible to special groups who could truly appreciate their experiences at the outreach events.

4. RELATED WORK

Studying various technology programs nationwide proved to be very helpful in making our Newark and Paterson workshops a success. The Center for Learning and Teaching a Program (CLTP) is responsible for running a workshop where the main goal is to educate people interested in the science, technology, engineering, and math fields (STEM) in order to recruit them as potential teachers for educating and helping to build interest in students aged from kindergarten through seniors in high school [4]. Unlike CLTP, the Department of Informal Science Education (ISE)’s main program goal is to increase public interest – specifically the interest of younger scholars and senior citizens – in technology and the engineering field in general, with the intent of gearing the younger scholars towards engineering careers [4].

Like these technology outreach programs, the Newark and Paterson curricula are designed to increase public interest in the engineering and technology fields for younger students. The curricula are also designed to increase computer literacy for less fortunate job seekers – some coming right out of jail – and for older senior citizens who often do not have the exposure to luxuries like the Internet, email, and word processors taken advantage of by everyday users. The purpose of these workshops would ultimately be to demonstrate to the public the importance of engineering and technology in today’s society.

As stated by leaders representing the Vanderbilt Center for Science Research, “Science is for all Americans” and “[it] should be something that students do, not something that is done to them”[9]. Therefore, unlike previous technology outreach workshops, like CLTP and ISE, our curricula are specifically designed so that there be one-on-one student to facilitator interaction. This, along with step-by-step PowerPoint presentations and evaluation surveys, are what make the Newark/ Paterson curricula more effective than the previous. Though also effective and honorable, the videoconferencing and online chat methods used by these other programs to connect student and professional are too impersonal, disallowing the student to truly appreciate the full benefits of the program.
5. DESIGN

5.1 Senior Citizens
The design of the senior citizen portion of the Outreach event in Newark included three areas: word processing, surfing the internet, and e-mailing. These three fields are all vital in working with a computer (See Appendix A).

The senior citizens were asked to fill out a before, as well as an after survey (See Appendix B). In addition, each senior citizen was paired with an assistant GSET scholar aiding them every step along the way during the program.

Word Processing
A Microsoft PowerPoint presentation was created to show the senior citizens how to properly use Microsoft Word 2007. It covered how to open the program, create a new document, and how to format and use the toolbar (See Appendix C for the PowerPoint).

Surfing the Internet
A Google Document Presentation was prepared to acquaint the senior citizens with the Internet and exactly how to use it. Though the presentation was focused on Mozilla Firefox 2.0, the senior citizens used Mozilla Firefox 3.0 and were also introduced to Internet Explorer and Opera (See Appendix D).

E-mail
The e-mail portion of the program for senior citizens did not have a visual aid. A GSET scholar showed the senior citizen how to operate a Gmail account and a Verizon e-mail account.

5.2 Job Seekers of Newark
The participants of this event are of various backgrounds, but are all searching for skills to better their chances of obtaining a job. One way to increase their chances of being hired is to show them how to use a computer. Although this program is similar to the senior citizen program, it focuses on the basic computer skills that would be useful on the job. This includes typing, word processing, calendars, resumes, e-mail, and internet (See Appendix E).

Typing
Some jobs involve a lot of typing so it is valuable to type accurately and fast to increase productivity. With this skill a job-seeker will have a much better advantage in getting a computing job because he will be able to get work done quickly. When learning to type efficiently one must start all the way at the beginning with the home keys: A, S, D, F, J, K, L, and ; (See Appendix M). Next they will be shown them which fingers hit which keys (See Appendix N).

Following the end of the program, participants will be provided with the list of online “typing tutors” shown below.

- http://www.typeonline.co.uk/index.html
The participants can continue to improve their typing even after the program is over.

**Microsoft Office**

Akin to the senior citizens, the participants of this program will learn to use Microsoft Word 2007 in addition to Microsoft PowerPoint 2007 and Microsoft Excel 2007.

The adults will learn Microsoft Word in more detail than the other two; they will learn to not only open up a new document and use the toolbar but also other functions: fonts, styles, formatting, margins, spacing, etc. (See Appendix C). For Microsoft Excel, the participants will familiarize themselves with basic spreadsheet features in this program including formulas, tables, charts, graphs, etc. Finally, for Microsoft PowerPoint the participants will be provided with the very basic skills: how to add slides, how to add pictures and charts, and how to transition slides.

**Calendars**

When on the job it is very useful to be organized and know when certain events or meetings are taking place. There is computer software that allows users to make and save a calendar available for use at all times during the work day. They will be taught how to create a new calendar, how to choose a month to work on, how to set up appointments, and how to set up alerts.

**Figure 1: Windows Calendar Maker**

For this, program Windows Calendar will be used (Figure 1).

**E-mail**

The e-mail portion of the program will be the same as the e-mail portion of the senior citizen event. (See section 5.1)

**Internet**

The Internet component of the program will be the same as the Internet component of the senior citizen program. (See section 5.1 or Appendix D)

**Resume**

In order to practice some of skills they will be given, the participants will write a resume using the template (Appendix F) and send it as an attachment in an email. By both writing and sending it, the participants can use the word processing skills, knowledge of email, and resume information that the program will provide them. (See Appendix F)
5.3 Engineering for Children

During the engineering for children program, young students were introduced to the field of engineering and technology in a way that was informative, but also fun. In designing the curriculum for the students from Newark and Paterson, it was imperative that a meaningful, personal, and hands-on experience be ensured. There were several components to this program. Prior to beginning, the students were asked to complete a simple survey (see Appendix H) in order to evaluate how much they already knew about engineering. We presented the students with the same survey afterwards to assess how much they learned through participating in our workshop. (See Appendix G)

Introduction

The day began with an overview and schedule of the program’s activities. Once the children were settled they were introduced to several specific fields of engineering: chemical, biomedical, aerospace, civil, mechanical, and computer.

Mentos and Coke

To demonstrate to the students how fascinating chemical engineering could be, we demonstrated the Diet Coke and Mentos experiment. When Mentos and Diet Coke are combined a reaction takes place and the soda explodes. For this to happen, the gelatin and Arabic gum found in the Mentos candies break the surface tension of the water. Therefore, it takes less work to expand and create bubbles. Carbon dioxide bubbles then form on the surface of the candies. Carbonated drinks have carbonic acid dissolved in them. However, since the dissociation of carbonic acid is spontaneous adding a little catalyst can make the dissociation explosive. Also, since the Mentos sink to the bottom of the bottle, when the gas is released it pushes the soda out of the bottle violently [13]. The chemical reaction that occurred as a result of placing just a few of these candies into the bottle of soda was a very exciting way to hold the students attention and keep them interested in hearing about the many different opportunities available to them with an engineering background. (See Appendix I)

Roller Coaster Fun

In the following activity we had the students construct a roller coaster made out of foam tubing, toothpicks, and tape. These mini-roller coasters had the task of carrying a marble through various turns and loops, and proved to be a very fun way to relate to something that they have already experienced by attending amusement parks and introducing the students to the field of civil engineering. Roller coasters were judged at completion and awarded points for different features. (See Appendix J)

Computer Engineering Activities

We later demonstrated Blender, “a free open source 3D content creation suite” for the students. This application is gaining popularity in the animation world (See Appendix I). This, along with the demonstration of the Computer
Controlled Room introduced the students to the world of computer engineering in a hands-on way. The Computer Controlled Room is a “room” designed by Governor’s School students to adjust to the preferences of an individual carrying the appropriate RFID card. In allowing the students to actually hold the RFID cards and run the program themselves, they had the opportunity to learn and see for themselves the growth of modern technology.

The Toppling Tower
Lastly, we had the students build a tower made solely out of DOTS candies and toothpicks. During this project, the students were able to use their imaginations (and engineering) to create their own designs. Points were awarded to the teams for height and strength. Each of these mini-demonstrations were performed with one-on-one student to facilitator interaction, ensuring student comprehension and maximizing entertainment in the various engineering fields. (See Appendix L)

6. CONCLUSION
The effectiveness of GSET’s 2008 Outreach Programs was evaluated based on surveys given to the participants both before and after the events. Based on the feedback given in those surveys—which were generally positive—it can be concluded that the outreach was, overall effective in meeting its basic objectives (i.e. in teaching the senior citizens basic computer literacy skills and in giving the young students an interest in science and engineering). It can be further said that, while even simple outreach programs such as this do take a large amount of time, planning, and resources to execute successfully, they can indeed be positive and beneficial to the community they intend to help.

If one were to recommend changes or improvements to be made in future GSET outreach programs, however, it can be suggested that in the future, the computer literacy curriculum for the senior citizens start at a simpler place. For example, while it was assumed that the seniors at the very least knew how to use a mouse and keyboard, even that could not be taken for granted in all cases. Thus, it would be better if the curriculum began at this level, beginning with basic interface navigation before moving on to more advanced topics like teaching Microsoft Office and email. Similarly, for the young students in the outreach, it was observed that they did not respond as well to the instructive materials presented in the slide shows as the hands-on activities and labs given by the outreach. In any case, future outreach programs would be better off simplifying planned curricula so as to broaden their reach and to serve their purposes more effectively.

Overall, the outreach program was effective in its basic goals of communicating basic computer skills and introducing young students to engineering topics to the senior citizens and young students, respectively. Future outreach programs can be improved from the experience gained from the one organized this year, but they will definitely have a positive effect if they are conducted in the same
manner as this year’s. Another suggestion for future outreach programs is to make sure all the logistics are taken care of far enough in advance. We had trouble with our job seekers of Newark event when we realized Governor’s School students did not have permission to work with ex-convicts (one the participant groups). Even with reassurance we were not allowed to send anyone there without the consent of their parents, and therefore the program was pushed forward to a date still to be determined.

7. ACKNOWLEDGEMENTS

Our project group would like to thank all the people who made this project possible. First, we would like to thank everyone involved with the Governor’s School of Engineering and Technology: Dean Brown, Blase Ur, and the Governor’s School of Overseers. We would also like to thank our project advisors, Sean DiStefano and Nancy Twu, for their excellent advice and helping us obtain supplies. Candiece White, Robin Wilensky, Linda Lagunzad, Roberto Salazar, and Newark Now should also be acknowledged for the help. We would also like to thank the Salvation Army Boys and Girls Club of Ironbound in Newark, New Jersey, all of the participants, and the volunteer GSET students who participated in the first run of the program. A special thanks goes out to Jen Siegel and Nicole Businelli for their Blender demonstration, and Kevin Tucker, Kerri Devine, and Kevin Ruiz for their Computer Controlled Room demonstration.

This project could not have happened without the help of the Governor’s School sponsors: Prudential, Morgan Stanley, Rutgers University, The John and Margaret Post Foundation, and John and Laura Overdeck.

8. CITATIONS


## APPENDIX

### TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Appendix Number</th>
<th>Title</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A</td>
<td>Senior Citizen Program- Curriculum</td>
<td>11</td>
</tr>
<tr>
<td>Appendix B</td>
<td>Senior Citizen Program- Survey</td>
<td>12-14</td>
</tr>
<tr>
<td>Appendix C</td>
<td>Senior Citizen Program/Job Seekers of Newark Program- Word Processor Power Point</td>
<td>15-18</td>
</tr>
<tr>
<td>Appendix D</td>
<td>Senior Citizen Program/Job Seekers of Newark Program- How to Use the Internet Power Point</td>
<td>19-20</td>
</tr>
<tr>
<td>Appendix E</td>
<td>Job Seekers of Newark- Curriculum</td>
<td>21-22</td>
</tr>
<tr>
<td>Appendix F</td>
<td>Job Seekers of Newark- Resume Template</td>
<td>23</td>
</tr>
<tr>
<td>Appendix G</td>
<td>Engineering for Children- Curriculum</td>
<td>24-28</td>
</tr>
<tr>
<td>Appendix H</td>
<td>Engineering for Children- Survey</td>
<td>29</td>
</tr>
<tr>
<td>Appendix I</td>
<td>Engineering for Children- Power Point</td>
<td>30-33</td>
</tr>
<tr>
<td>Appendix J</td>
<td>Engineering for Children- Roller Coaster Fun handout</td>
<td>34</td>
</tr>
<tr>
<td>Appendix L</td>
<td>Engineering for Children- The Toppling Tower handout</td>
<td>35</td>
</tr>
<tr>
<td>Appendix M</td>
<td>Job Seekers of Newark- Home Keys</td>
<td>36</td>
</tr>
<tr>
<td>Appendix N</td>
<td>Job Seekers of Newark- Finger Assignments</td>
<td>36</td>
</tr>
</tbody>
</table>
Appendix A: Senior Citizen Program-Curriculum

I. Welcome
   a. Introduce our program
   b. Outline the events for the day
      i. Basics of Microsoft Office
         1. Microsoft Word
      ii. How to create an e-mail account
      iii. How to use and surf the internet
      iv. Have them write a letter and attach it to an e-mail

II. Microsoft Word
    a. How to open
    b. How to create a new document
    c. Toolbar
       i. Font and font size
       ii. Bold, italics
       iii. Color
       iv. Bullets and numbers
       v. Line spacing
       vi. Text alignment
       vii. Copy and paste
    d. Page layout
    e. How to print and how to make copies

III. E-mail
     a. How to create an e-mail account
     b. How to check for new e-mails
     c. How to send a message
     d. Spell check
     e. attachments

IV. Internet
    a. How to open
    b. What is a URL?
    c. Search engines
       i. Show an example: “online greeting cards” and show them some websites they could use
    d. How to add something to your favorites

V. Letter
    a. Have them write a letter and send it to us as an attachment in an e-mail
Appendix B: Senior Citizen Program- Survey

Newark Senior Outreach
The New Jersey Governor’s School of Engineering & Technology
July 12, 2008

For the following questions, choose the response that most accurately indicates your comfort level in each topic (1=lowest, 7=highest).

1) I am generally comfortable using the computer on my own.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

2) I am comfortable saving, deleting, moving, and renaming files within a word processor.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

3) I can successfully identify the “ribbon” within a word processor.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

4) I feel comfortable manipulating the font styles, margins, and line spacing within a word processor.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree
5) I feel comfortable with the basic formatting involved within a word processor (i.e.: right align, center, left align)
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

6) I feel comfortable enough to access the Internet on my own as often as possible.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

7) I understand how to locate and enter addresses into the URL bar.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

8) I know how to compose email messages with the proper subject, greetings, and other etiquette.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
   g. ______ 7 – Agree

9) I am comfortable sending and opening file attachments using email.
   a. ______ 1 - Disagree
   b. ______ 2
   c. ______ 3
   d. ______ 4
   e. ______ 5
   f. ______ 6
10) I am comfortable using online search engines like Google and Yahoo.
   a. _______ 1 - Disagree
   b. _______ 2
   c. _______ 3
   d. _______ 4
   e. _______ 5
   f. _______ 6
   g. _______ 7 – Agree

AFTER the program

11) Which topic discussed do you feel was the most effective and helpful? Which was the least effective? Please elaborate.

___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________

12) On a scale of 1-7, please evaluate your “tutor” (1=worst, 7=best) _____________
   What did you like (or dislike) about their teaching methods? Please elaborate.

___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________

13) Please feel free to add anything concerning how you felt about our program and topics that you feel should be added/removed to help us to improve for future presentations.

___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________

THANK YOU FOR YOUR PARTICIPATION!
NJGSET ‘08
Appendix C: Senior Citizen Program/Job Seekers of Newark Program- Word Processor Power Point

Using Microsoft Word

Word: An overview
- Microsoft Word is a word processing software package.
- It can be used to type letters, reports, and other documents.
- In this lesson, the fundamental topics of Microsoft Word will be covered, including creating files, formatting text, editing text, and using other basic features.

Opening a blank document

Opening a blank document
- To open a blank document, click the Microsoft Office button in the upper left hand corner and then click "New."
- Click "Blank Document," and then click "Create." This will open a new blank document.

Word 2007 main screen

Word 2007 main screen
- The text area is the area in which the document is typed.
- The blinking vertical line in the upper left-hand area of the text area is called the cursor; it marks your typing point.
- The vertical and horizontal scroll bars allow you to move up and down the page by clicking and dragging on them.
Word 2007 “ribbon”

- The ribbon, the set of buttons found at the top of the screen, is used to issue commands.
- The tabs at the very top of the ribbon select which set of commands you want to be able to choose from.
- For example, the home tab will present buttons for font, editing, and formatting.
- The ruler, found below the margins of the text area and document.

The Status Bar

- The status bar, which appears at the very bottom of the document, presents such information as the current page and number of words in the document.
- The spell check button, which automatically checks all of the text you have written for spelling and grammatical errors, is also found on the status bar.

Using the Cursor

- Use the mouse and up, down, left, and right arrow keys to place the position of the cursor, the blinking vertical line that marks your typing point.
- To highlight a certain section of text, click and drag the cursor using your mouse over the area you desire highlighted.
- Press “Enter” to start a new paragraph and “Tab” to indent it.

Bold, Italicize, and Underline

- When creating a document, you may need to emphasize particular words or phrases by bolding, underlining, or italicizing.
- Using the cursor, highlight the desired area and using the ribbon toolbar, click the B, I, or U keys to Bold, Italicize, or underline, respectively.
Changing the Font

- To change the font, the size or type of letters being printed, click on the small rectangle in the bottom right corner of the font button found in the ribbon bar to open the font menu shown right.

Undo and Redo

- The undo and redo buttons allow you to correct mistakes by taking away or putting back typos or wrong commands you may have made.
- For example, type Undo Example. Then press the Undo button, found in the upper left hand corner. The writing disappears.
- Then press the Redo button, found next to the Undo button. The writing reappears.

Formatting

- Changing the margins: Select the Page Layout tab and then click on the “Margins” button to pick the best margin settings.
- Line Spacing: Choose the Home tab and then click the launcher in the paragraph group. When the “Paragraph” dialog box appears, you can change anything from line spacing (single, double, 1.5, or other) to the indentations and alignment.

Formatting

- Adding Page Numbers: Select the Insert Tab and then click on the “Page Number” button.
- Adding Date & Time: Select the Insert Tab and then click on the “Date & Time” button.
- Adding a Cover or Blank Page: Select the Insert Tab and then click on the “Cover Page” or “Blank Page” buttons.
- Choosing Paper orientation: Choose the Page Layout Tab and then click on the “Paper Orientation” button; a Portrait paper is upright, while Landscape paper is sideways.
Just the basics

- The material covered today represents just the very basic features present in Microsoft Word.
- Word 2007 has so many new features and options it can take months to fully master it.
- Thus, you should not be discouraged if you find it difficult to use Word at first; it is a matter of patience and getting used to the new interface.

References

1. Microsoft Word online training guide
   http://www.baycongroup.com/wlesson0.htm
Appendix D: Senior Citizen Program/Job Seekers of Newark Program- How to Use the Internet Power Point

What is the internet anyway?
- World Wide Web
  - Contains a "web" of electronic documents stored on other computers around the world known as servers

How do I access the internet?
- Get to your PC (Personal Computer)
- Open up a Web Browser.
  - A Web Browser is a computer program that is used for surfing the internet (e.g., Firefox, Internet Explorer, Opera, etc.)

I still don't quite understand what a URL is.
- A URL follows a certain syntax that indicates exactly where the web page you are looking at is stored online.
- The address field at the top of your browser is where you enter the URL.
- Examples:
  - Home Pages
  - Blogs
  - Directories
  - Newsgroups

How do I access the internet?
- Enter a URL (Uniform Resource Locator) to access a web page.
  - Web servers around the globe contain these web pages for you to access.
- You can also click a link on a web page to access more web pages.
  - A link is usually an underlined word above which the cursor turns into a hand.
What if I have no idea where I want to go?
- If you have something in mind that you want to read about but have no where to look, the internet can still help you! Use a search engine, special designed web pages that search throughout the internet (e.g., www.google.com or www.yahoo.com).

Navigation
- What are those wacky buttons at the top of the screen?
- Back Button: Lets you maneuver back
- Forward Button: Lets you navigate forward
- Home Button: Sets up your homepage (we will talk about this later)
- Refresh Button: Lets you reload the webpage
- Stop Button: Lets you stop
- Print Button: Prints the web page for you

Home Page
- If you have a favorite website that you want to look at whenever you go online then you might want to set it as your homepage.
- In Firefox, we click 'Tools' then 'Options'. A window should open up, choose the Startup section and set the Home Page to the URL of your favorite page.

Bookmarks
- In Firefox, if you really like a website you can bookmark the website. This means you can revisit the website whenever you want to.
  1. Click 'Bookmarks' on the toolbar at the top of the browser while you are on the website.
  2. Click 'Add to Bookmarks' opening up a window.
  3. Click 'OK'.
  4. You can also click Ctrl+D to bookmark a page.

Done?
- Click the [X] button on the top right of the browser. This will close the browser. The other buttons from left to right will either minimize the browser window or restore up/down.
Appendix E: Job Seekers of Newark- Curriculum

VI. Welcome
   a. Introduce our program
   b. Outline the events for the day
      i. Improve typing skills
      ii. Basics of Microsoft Office
         1. Microsoft Word
         2. Microsoft Excel
         3. Microsoft Power point
      iii. Show them how to make a calendar online using Windows Calendar
      iv. How to create an e-mail account
      v. How to use and surf the internet
      vi. Have them make a resume

VII. Improving typing skills
   a. Start from the beginning by introducing the QWERTY keyboard
   b. Teach about the home keys and where to place their fingers
   c. Show them which fingers hit which keys (picture)
   d. Since we have to show them so many things in a short amount of time we will give them websites they can go to in order to practice
      - http://www.typeonline.co.uk/index.html
      - http://www.powertyping.com/
      - http://www.typingtest.com/

VIII. Microsoft Office
   a. Microsoft Word
      i. How to open
      ii. How to create a new document
      iii. Toolbar
         1. Font and font size
         2. Bold, italics
         3. Color
         4. Bullets and numbers
         5. Line spacing
         6. Text alignment
         7. Copy and paste
      iv. Page layout
      v. How to print and how to make copies
   b. Microsoft Excel
      i. Just the basics
      ii. How to enter text or numbers in the columns
      iii. Formulas (add, subtract, multiply, divide)
      iv. Tables
      v. Charts
      vi. graphs
      vii. How to copy and paste
c. Microsoft Power Point
   i. How to choose an opening slide
   ii. How to add slides
   iii. How to make a background
   iv. How to add picture and charts
   v. How to transition from slide to slide

IX. Calendars
   a. How pick a month and year
   b. How to set up appointments, meetings, and events
   c. How to make it alert you for special events
   d. How to easily assign an appointment to every day of the week, every day of a month, etc.

X. E-mail
   a. How to create an e-mail account
   b. How to check for new e-mails
   c. How to send a message
   d. Spell check
   e. attachments

XI. Internet
   a. How to open
   b. What is a URL?
   c. Search engines
      i. As an example: “job search” and show them possible websites they can go to and look for a job
   d. How to add something to your favorites

XII. Resume
    a. To use what they learned we will have them write a resume using the resume template we give them
    b. Can use to get a job
Appendix F: Job Seekers of Newark- Resume Template

Your Name
Address
City, STATE Zip.
Phone Number
Email address

PROFESSIONAL EXPERIENCE

<table>
<thead>
<tr>
<th>Company Name, City, State</th>
<th>Position Title, Month Year – Present</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Accomplishment/Achievement, quantify and illustrate scale/scope</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Company Name, City, State</th>
<th>Position Title, Month Year – Present</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Accomplishment/Achievement, quantify and illustrate scale/scope</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Company Name, City, State</th>
<th>Position Title, Month Year – Present</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Accomplishment/Achievement, quantify and illustrate scale/scope</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Company Name, City, State</th>
<th>Position Title, Month Year – Present</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List Accomplishment/Achievement, quantify and illustrate scale/scope</td>
</tr>
</tbody>
</table>

EDUCATION

<table>
<thead>
<tr>
<th>School Name, City, State</th>
<th>Degree in Subject, Year Graduated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minor in Subject</td>
</tr>
<tr>
<td></td>
<td>List Positions held in Student Associations, Awards Won, Deans List, etc.</td>
</tr>
<tr>
<td></td>
<td>List Positions held in Student Associations, Awards Won, Deans List, etc.</td>
</tr>
</tbody>
</table>

TECHNICAL SKILLS

- Enter one per line
- Enter one per line
- Enter one per line

LICENSEURE

- List Certifications, Licenses (e.g., Series 7 for Finance, DEA License for Nurses, etc.)

ADDITIONAL SKILLS

- List Foreign Languages
- List Software/Hardware
Appendix G: Engineering for Children- Curriculum

I. Welcome
   a. Introduction of project members
   b. Today's events slide
   c. Introduction of the engineering fields to be covered

II. Aerospace Engineering
   a. NASA
      i. Rocket programs to space
      ii. Mars Lander projects
      iii. Hubble Telescope
      iv. International Space Station
      v. Moon Base possibility by 2020
      vi. Man on Mars possibility by 2037

III. Biomedical Engineering
   a. Definition
      i. Application of engineering principles and techniques to the medical field
   b. Uses
      i. Medical Devices
         1. Artificial limbs and organs
      ii. Medical Imaging
         1. X-Rays
         2. MRI

IV. Chemical Engineering
   a. Definition
      i. The application of chemistry and physics, with mathematics, to converting chemicals into valuable forms
   b. Examples
      i. Ultra-strong fibers, fabrics, adhesives, and composites for vehicles
      ii. Bio-compatible materials for implants and prosthetics
      iii. Gels for medical applications

V. Chemical Engineering (Mentos and Soda Experiment)
   a. Things to think about
      i. How do Mentos and soda react when combined with one another?
ii. What might happen if other kinds of candy are used besides Mentos?

VI. **Mentos and Soda Experiment**
   a. Directions
      i. Put a Mento in the cap of the soda bottle
      ii. Cap the bottle quickly and shake the bottle
      iii. Watch the bottle explode as if the cap was a rocket
   b. Questions
      i. How do Mentos and soda react when combined with one another?
      ii. What might happen if other kinds of candy are used besides Mentos?

VII. **Civil Engineering**
   a. Definition
      i. The design, construction and maintenance of the physical and natural built environment
   b. Works
      i. Bridges
      ii. Roads
      iii. Canals
      iv. Dams
      v. Buildings
   c. Structural Engineering
      i. Planning and execution of the designs from structural engineers
      ii. Knowledge
         1. Critical Thinking
         2. Listening
         3. Problem Solving
         4. Decision Making

VIII. **Mechanical Engineering**
   a. Definition
      i. The application of principles of physics for analysis, design, manufacturing, and maintenance of mechanical systems.
   b. Structural Analysis
      i. Why did it fail?
         1. Static structural failure
            a. Object either breaks or is deformed
         2. Fatigue Failure
a. Object fails after a number of repeated loading and unloading cycles
   ii. What can we do to improve it?

IX. Civil and Mechanical Engineering
   a. Introduction to Roller Coaster experiment
      i. Designing a roller coaster for marbles
      ii. Using piping to design it
   b. Introduction to Toothpick Tower experiment
      i. Building a tower out of toothpicks and gum drops
      ii. Building the tallest tower and getting it to hold the most weight

X. Roller Coaster Construction
   a. Pre-questions
      i. How many of you have ever been to Six Flags or another amusement park?
      ii. Did you know?
         1. Without engineering these rides would not exist
   b. Rules
      i. Items you can use
         1. Piping
         2. Marble
         3. Cup
         4. Chairs
         5. Tape
         6. Other objects to make it loop and curve
   c. Scoring
      i. 1 Point
         1. Going up a hill
      ii. 3 Points
         1. U-turn
      iii. 5 Points
         1. Loop
      iv. 10 Points
         1. Marble flies off track and into a cup
   d. Post-questions
      i. When would you have had to make the marble go faster or slower in the roller coaster?
      ii. How did or how could you get the marble to go into the cup?

XI. Computer Engineering
a. Engineers who have training in the areas of software design and hardware-software integration
   i. Firmware development, software development, hardware-integration, and circuit design
b. Computer engineers helped program the Mars Lander that recently went to space using a common programming language known as Java

XII. Java on Mars
a. Maestro
   i. Collaborative command and control system
      1. Data visualization, collaboration, command & control
      2. Looks at images and creates 3D reconstructions of terrain
      3. Cleaned up version for civilians
b. Java API
   i. Java advanced imaging
      1. Combines two different images from the Rover’s cameras to create a panorama
      2. Stereo-image correlation calculates how far away the element in the picture is

XIII. Blender Demonstration
a. Introduce Blender demonstrators
b. Demonstration of Blender
   i. Show how to create a penguin in Blender

XIV. Toppling Tower Experiment
a. Pre-Questions
   i. What exactly is a tower?
      1. Towers are tall, man-made structures that are always taller than they are wide
   ii. Why are towers used?
      1. When there is a limited amount of space to be used on the ground so they build up
b. Goal
   i. To build a tower 6 inches or higher that can hold at least one can of tuna
   c. Materials
      i. Ruler
ii. DOTS
iii. Toothpicks
iv. Tuna Cans

d. Requirements
   i. Your tower must be at least 6 inches high
   ii. Your tower must hold at least one can of tuna
   iii. You can ask for more supplies
   iv. You must be able to move your tower to the test station

e. Points
   i. 8 points per inch
   ii. 5 points per can
   iii. -25 points if your tower is less than 6 inches
   iv. -25 points if your tower cannot hold 1 can
   v. -10 points if you ask for more supplies

f. Questions
   i. Why did your tower fall?
   ii. What could you have done to fix it?

XV. Recap
   a. Fields of Engineering
      i. Aerospace
      ii. Biomedical
      iii. Chemical
      iv. Computer
      v. Civil
      vi. Mechanical

   b. Thinking like an engineer
      i. Making decisions based on problems you see

   c. Experimentation
      i. Testing your ideas before you implement them

   d. Time constraints
      i. Learning deadlines and having a successful product
Appendix H: Engineering for Children- Survey

Newark Middle School Outreach
New Jersey Governor’s School of Engineering and Technology
July 12, 2008

1) What is an engineer?
________________________________________________________________________

2) How many different types of engineers can you think of? _________________
   Name as many as you can:

3) Have you ever been to an amusement park? ________________________________
   Who do you think is responsible for constructing the types of rides found there?
   ______________________________________________________________________
   ______________________________________________________________________

4) What other types of jobs do engineers have?
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________

5) Do you think engineering can be fun? Why or why not?
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
Appendix I: Engineering for Children - Power Point

**Engineering and Technology**
Governor's School Outreach Program

**Today's Events**
- Introduction
- Mentos and Soda Experiment
- Roller Coaster Construction
- Blender Demonstration
- Tower Construction

**Fields of Engineering**
- Aerospace
- Biomedical
- Chemical
- Computer
- Civil
- Mechanical

**Aerospace Engineering**
- NASA
  - Rocket programs to space
  - Mars mission
  - Hubble Telescope
  - International Space Station
  - Moon Base estimated by 2020
  - Man on Mars feasibility by 2037

**Biomedical Engineering**
- Application of engineering principles and techniques to the medical field
- Uses
  - Medical Devices
    - Artificial limbs and organs
  - Medical Imaging
    - X-Rays
    - MRI

**Chemical Engineering**
- The application of chemistry and physics, with mathematics, to converting chemicals into valuable forms.
- Examples:
  - Ultra-strong fibers, fabrics, adhesives and composites for vehicles
  - Bio-compatible materials for implants and prosthetics
  - Gels for medical applications
Chemical Engineering
- Mentos and Soda Experiment
  - How do Mentos and Soda react when combined with one another?
  - What might happen if other kinds of candy are used besides Mentos?
  - Think about these questions before the experiment is completed.

Mentos and Soda Experiment
- Put a mento in the cap of the soda bottle.
- Cap the bottle quickly and then shake the bottle.
- Watch the bottle explode as if the cap was a rocket.

Mentos and Soda Questions
- How do Mentos and Soda react when combined with one another?
- What might happen if other kinds of candy are used besides Mentos?

Civil Engineering
- The design, construction, and maintenance of the physical and natural built environment
- Works:
  - Bridges
  - Roads
  - Canals
  - Dams
  - Buildings

Civil & Mechanical Engineering
- Roller Coaster Construction
  - Designing a roller coaster for marbles.
  - Using piping to design it.
- Tower Construction
  - Building a tower out of toothpicks & gum drops.
  - Building the tallest tower and getting it to hold the most weight.

Mechanical Engineering
- The application of principles of physics for analysis, design, manufacturing, and maintenance of mechanical systems
- Structural Analysis:
  - Why did it fail?
  - Static
  - Structural
  - What can I do to improve?
Roller Coaster Construction

- How many of you have ever been to Six Flags or another amusement park?
- Did You Know?
- Without engineering these rides would not exist.

Roller Coaster Rules

- Items You Can Use:
  - Piping
  - Marble
  - Cup
  - Chairs
  - Tape
  - Other objects to make
- Scoring:
  - 1 Point - Being up a hill
  - 3 Points - U-Turn
  - 5 Points - Loop
  - 10 Points - Marble flies off truck and lands in a cup

Roller Coaster Questions

- When would you have to make the ball go faster or slower in the roller coaster?
- How did or how would you get the marble to go into the cup?

Computer Engineering

- Engineers who have training in the areas of software design and hardware - software integration
- Firmware development, software development, hardware - integration, and circuit design
- Computer engineers helped program the Mars Lander that recently went to space using a common programming language known as Java.

Java on Mars

- Let's Visit the Rover:
  - http://www.sun.com/aboutsun/media/features/mars.html powered by Sun

Mars Rover: Powered by Java

- Maestro - collaborative command and control system
- Data visualization, collaboration, command & control
- Analyzes images and creates 3D reconstructions of terrain
- Cleaned up version for civilians
- Java API - Java Advanced Imaging
- Combines two different images from the Rover's cameras to create a panorama
- Stereo image correlation calculates how far away the element in the picture is
Toppling Tower Questions

Q: What exactly is a tower?
A: Towers are tall, man-made structures that are always taller than they are wide.

Q: Why are towers used?
A: When there is a limited amount of space to build on the ground so they build up.

Toppling Tower Construction

- Goal:
  - To build a tower 6 inches or higher that can hold at least one can of tuna.

- Materials:
  - Ruler
  - DOTS
  - Toothpicks
  - Tuna Cans

- Requirements:
  - Tower must be at least 6 inches high
  - Tower must hold one can of tuna
  - Must be able to move your tower to the test station

- Scoring:
  - 6 Points per inch
  - 3 Points per can
  - -25 if your tower is less than 6 inches
  - -25 if your tower cannot hold 1 can of tuna

Toppling Tower Questions

Why did your tower fall?
What could you have done to fix it?

Recap

- Thinking like an engineer
- Enjoying the job that you want to do in life
Appendix J: Engineering for Children- Roller Coaster Fun
handout

ROLLER COASTER FUN!!

GOAL: To build a rollercoaster for marbles to “ride”.

MATERIALS:    marbles
                Piping
                Masking tape
                Cup
                Point sheets

There is no set procedure for this project. Basically, you are an engineer, and you must build a prototype of an awesome and fun-filled rollercoaster for Great Adventure.

TIPS & GUIDELINES:    Unlike the roller coasters you ride, this will not be a complete circuit (or track). You want the marble to land in the cup.
                        You will need to tape the piping together to make your track.
                        You can use anything you can think of to make hills and ramps
                        Start on the wall, so you can start your roller coaster on a hill.

POINTS:  1 point for each hill the marbles makes it over.
         3 points for each u-turn
         5 points for each loop
         10 points if the marble lands in the cup

30 minutes to build
THE TOPPLING TOWER!!

GOAL: To build a 6” or higher tower that can hold at least one can of tuna out DOTS and toothpicks.

MATERIALS: ruler
DOTS
Toothpicks
Tuna cans

You are to build any tower you like, but you must follow a few guidelines.
  • Your tower must be at least 6” high
  • Your tower must hold one can of tuna
  • You must be able to move your tower to the test station

POINTS:  8 points per inch
         5 points per can
         -25 points if your tower is less than 6”
         -25 points if your tower cannot hold 1 can

30 minutes to build
Appendix M: Home Keys

Appendix N: Finger Assignments